
Tied-back excavation using HSsmall

TIED-BACK EXCAVATION

Using the HSsmall model
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INTRODUCTION

A building pit was constructed in the south of the Netherlands. The pit is 15 m deep and 30 m
wide. A diaphragm wall is constructed using 100 cm diameter bored piles; the wall is anchored
by two rows of pre-stressed ground anchors. In this exercise the construction of this building
pit is simulated and the deformation and bending moments of the wall are evaluated.
The upper 40 m of the subsoil consists of a more or less homogeneous layer of medium dense
fine sand with a unit weight of 18 kN/m3. Triaxial test data of a representative soil sample is
given in figure 2. Underneath this layer there is very stiff layer of gravel, which is not to be
included in the model. The groundwater table is very deep and does not play a role in this
analysis.

AIMS

• Using interface elements

• Using ground anchors

• Pre-stressing of anchors

• Combination of structural elements
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Figure 1: Geometry for tied-back excavation
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MATERIAL PARAMETERS

Determination of stiffness & strength properties (sand)

In this exercise the HSsmall model is used and the model parameters for the sand layer
have been extracted from the triaxial test data (see figure 2). The HSsmall model takes into
account the stress-dependency of soil stiffness, elasto-plastic behaviour under both compres-
sion loading and shear loading and increased stiffness in areas with very low strain levels.
The soil parameters can be found in table 1, while the determination of the soil parameters
can be found in appendix A.

Figure 2: Triaxial test data for the sand layer

Secant wall

The secant wall consists of 100cm diameter bored piles with an intermediate distance of 80cm,
hence there is a 20cm overlap of the piles. This configuration is taken this into account for the
determination of the cross sectional area (A) and moment of inertia (I) per meter out-of-plane
(see Appendix B). The concrete stiffness is Ec=2.7•107 kN/m2 with a specific weight γ=16
kN/m3, which leads to the material parameters as given in Table 2. The determination of the
stiffness parameters can be found in Appendix A.
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Table 1: Soil parameters for the HSsmall model
Parameter Symbol Sand(Rinter=0.6) Sand(Rinter=1.0) Unit

Material model Model HSsmall HSsmall –
Type of behaviour Type Drained Drained –

Unsaturated weight γunsat 18.0 18.0 kN/m3

Saturated weight γsat 18.0 18.0 kN/m3

Drained triaxial test stiffness Eref
50 2.0·104 2.0·104 kN/m2

Drained primary oedometer
stiffness

Eref
oed 2.0·104 2.0·104 kN/m2

Unloading/reloading stiffness Eref
ur 8.0·104 8.0·104 kN/m2

Power for stress-dependent
stiffness

m 0.5 0.5 –

Cohesion c’ 1.0 1.0 kN/m2

Friction angle ϕ′ 35 35 º
Dilatancy angle ψ 5 5 º

Small-strain shear modulus Gref
0 10.0·104 10.0·104 kN/m2

Threshold shear strain γ0.7 1.5·10−4 1.5·10−4 –
Unloading/reloading Poisson’s

ratio
ν ′ur default default –

Reference stress pref default default kN/m2

Coefficient for lateral stress
under primary loading

KNC
0 default default –

Interface strength reduction Rinter 0.6 rigid –
Coefficient for lateral initial

stress
K0 automatic automatic –

Ground anchors

The anchors are made of 32mm diameter steel bars at an intermediate distance of 1m. The
steel bars have a stiffness of Es=2.1*108 kN/m2. The anchors have an ultimate strength
of 605 kN per anchor. In combination with a secant wall the anchors may be prestressed
to a maximum level of 60% of the ultimate strength, hence up to 363 kN per anchor. The
maximum compression force of the anchor is not important as the anchors will not be loaded
under compression. The grout body that forms the bonded length of the anchor behaves
relatively weak under tension compared to the steel bar inside. Therefore it is assumed that
both stiffness and strength of the bonded part of the anchor are fully determined by the steel
bar. This leads to the material properties for both the anchor rod (free length) and grout body
(bonded length) as given in tables 3 and 4.
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Table 2: Properties of the secant wall (plate)
Parameter Symbol Secant wall Unit

Material behaviour Material type Elastic –
Axial stiffness EA 2*107 kN/m

Flexural stiffness EI 1.67*106 kN/m2/m
Weight w 15.0 kN/m/m

Poisson’s ratio ν 0.15 –

Table 3: Properties of the anchor rods (node-to-node anchors)
Parameter Symbol Anchor rod Unit

Material behaviour Material type Elastoplastic –
Axial stiffness EA 1.7*105 kN

Spacing Lspacing 1.0 m
Max. tension force |Fmax,tens| 605 kN

Max. compression force |Fmax,comp| 605 kN

Table 4: Properties of the grout bodies (geotextiles)
Parameter Symbol Grout body Unit

Material behaviour Material type Elastoplastic –
Axial stiffness EA 1.7*105 kN/m

Max. tension force Np 605 kN/m
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GEOMETRY INPUT

• Start a new project

Project properties

• Accept the default values in the Project tab sheet of the Project properties (15-node
elements). For the dimensions see figure 3.

Figure 3: Project propeties, tabsheet Model

Geometry
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Figure 4: Geometry of the model

• Click the Geometry line button and draw the geometry contour and soil layers as
specified in figure 4.
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• Click the Plate button and draw the secant wall from (15, 0) to (15, -25).

• Click the Interface button and draw the interface from (15,0) to (15, -27) and back to
(15,0). This creates an interface on both sides of the secant wall.

• Click the Geotextile button and insert both grout bodies.

• Click the Node-to-node anchor button and insert both anchor rods. These anchors
connect the beginning of the grout bodies to the wall.

• Finally, click the Geometry line button again to introduce the two levels of excavation.

Hints: As interfaces can be introduced on both sides of a geometry line, one
should pay attention to the arrows on the cursor. These arrows indicate
where the program will locate the interfaces.

> Please note that the interface is extended for a short distance underneath
the beam. This is done to overcome a singular point at the bottom of the
wall.

Hint: It is not necessary to create a geometry line before creating plates,
geogrids or anchors. When drawing a plate or geogrid, a geometry line is
automatically added. Anchors do not create corresponding geometry
lines. This is not necessary since anchors do not interact with the
underlying soil.

Fixities

• Click the Standard fixities button to apply standard boundary conditions.

Material properties

• Enter the material properties for the four soil data sets, as determined in table 1of this
exercise.

• After entering all properties for the three soil types, drag and drop the properties to the
appropriate clusters.

• Enter material properties for the plates, anchors and ’geogrids’ as indicated in tables 2,
3and 4.
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Mesh generation

• From the Mesh menu, set the Global coarseness to Medium and press the Generate
button. This will result in a mesh as shown in figure 5.

Figure 5: Medium finite element mesh

• Select the geogrid and plate elements and press Refine line from the Mesh menu. This
will result in a refinement around the selected lines as shown in Figure 6.

Figure 6: Refined finite element mesh
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CALCULATION

• When starting the calculation program choose the Classical mode.

The entire construction process consists of five phases. Define the phases, as shown graph-
ically below. For each phase, use the Plastic calculation, Staged construction.

Initial phase

For the initial phase choose the K0procedure for calculating the initial stresses. As the phreatic
line is located below the geometry the generation of initial pore pressures can be skipped and
since it’s not necessary to switch off any soil for the initial situation it is not needed to define
the initial phase.

Phase 1

• In the first phase, the diaphragm wall is activated and the first excavation takes place.

• Note that though the the interfaces along the wall are activated automatically with the
activation of the wall, the extensions below the diaphragm wall have to be activated
manually.

Figure 7: Phase 1: activation of the wall
and 1st excavation

Figure 8: Phase 2: activation and
presstressing of the 1st anchor

Phase 2

In the second phase, a new option is used, namely the prestressing of anchors.

• First the grout-body (the geogrid) is switched on by clicking on the ’geogrid’ element.
The element will appear in yellow as soon as it is switched on. The light grey colour
indicates non-active elements.
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• Now that the grout-body is active, the anchor element needs to be prestressed. By
double clicking on a node-to-node anchor a window will appear as shown in figure 9.

• Select the option Adjust prestress, fill in a prestress force of 300 kN/m (tension) and
press OK.

• In the geometry a black node-to-node anchor indicates that the anchor is activated. The
letter P indicates that a prestress force will be active in the anchor.

Figure 9: Node-to-node anchor properties

Phase 3, 4 and 5

Now define the remaining phases according to figures 10, 11 and 12.

• In phase 3 excavate the second part of the excavation

• In phase 4 activate the lower anchor and prestress it to 300 kN/m

• In phase 5 excavate the remaining 3rd part.

Hint: When processing an anchor in a certain calculation phase the anchor
force will exactly match the prestress force at the end of that phase. In
following calculation phases without prestressing, the anchor force will be
influenced by the excavation process
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Figure 10: Phase 3: Second excavation Figure 11: Phase 4: Activation and
prestressing of 2nd anchor

Figure 12: Phase 5: Final excavation
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INSPECT OUTPUT

The results of fase 5 is presented in Figure 13. After this final stage the excavation bottom
heave calculated is about 5 cm.

Figure 13: Deformed mesh (phase 5)

• By double clicking on the node-to-node anchors, Plaxis will present a table, in which the
stress in all anchors may be inspected. Anchor forces are approximately 340 kN where
the lower anchor has a slightly higher anchor force than the upper anchor.

When double-clicking on one of the geogrids the change of axial forces within the grout body
can be investigated. What is immediately noticeable is that the axial force at the connection
with the anchor rod is significantly lower than the force in the anchor rod itself. This is due the
fact that the end of the anchor rod is not only connected to the grout body, but also to several
soil elements surrounding the end of the anchor rod. Therefore part of the anchor force is
transferred directly to those soil elements while part of the anchor force is transferred to the
geotextile representing the grout body. The amount of force transferred to the soil depends on
the stiffness of the soil; in this exercise it is 25-35% of the anchor force. However, this effect
has very little influence on other calculation results. That is, it is not so important for other
calculation results how the anchor rod transfers its force; directly to the soil or by means of the
grout body.

• By double-clicking on the wall the structural forces in the wall can be inspected. The
maximum bending moment should be in the order of 350 kNm/m (figure 14)

• When double-clicking on an interface only the results of part of the interface can be seen.
In order to see the results for the whole interface chain, keep Ctrl + Shift pressed on the
keyboard while double-clicking on the interface. In figure 15the left side are the passive
earth pressures and the right side are the active earth pressures. It can be seen that
only a small part of the maximum passive earth pressures has been mobilized at this
stage.
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Figure 14: Bending moments in the sec-
ant wall

Figure 15: Effective normal stresses in the
interface

Geometry size

For any project the geometry has to be made sufficiently large so that the boudary conditions
have no influence on the calculation results. This means in practice that close to the boundar-
ies (with exception of a axis of symmetry) displacements should be small and stresses should
be undisturbed. When using the HSsmall model there is an interesting plot that can be used
to check this.

• From the Stresses menu choose the option State parameters and then G/Gur.

This plot shows the actual shear stiffness divided by the unloading/reloading shear stiffnes
at engineering strain level. For areas with very small deformations the stiffness will be high
(small strain stiffness) and so the value of G/Gur> 1. Hence, the geometry is sufficiently large
if next to the boundaries, with exception of the axis of symmetry, G/Gur> 1, which indeed is
the case.

Hint: State parameters are additional quantities that relate to the state of the
material in the current calculation step, taking into account the stress
history. Examples of state parameters are the isotropic overconsolidation
pressure (pp) and the hardening parameter γp that specifies the maximum
shear strain level reach in the stress history.
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Surface settlements

In Plaxis Output it is possible to see calculation results in a user-defined cross section. This
feature will be used to check the surface settlements behind the secant wall.

• Click the Cross section button . The Cross section points window appears, see figure
16.

It is possible to draw a cross section by hand and check in the Cross section points window
what the coordinates are of the start and end point of the cross section. However, it is also
possible to position the cross section at a specific location by defining the coordinates of the
start and end point manually.

• Move the mouse to the Cross section points window and fill in the coordinates (15, -0.1)
for the first point and (70, -0.1) for the second point and press OK. This will create a
cross section from the secant wall until the right boundary of the model just below the
soil surface. The cross section will open in a new window.

• From the Deformations menu select Total displacements and then uy to see the vertical
displacements of the soil surface. The maximum settlement is 12-13 mm, see figure 17.

Figure 16: Cross section points window

Figure 17: Vertical displacements behind the secant wall
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APPENDIX A: DETERMINATION OF SOIL PARAMETERS FROM
TRIAXIAL TEST

Figure 18: Triaxial test for sand layer

Strength parameters

Fill in σ1and σ3in the Mohr-Coulomb criteria:

σ1 − σ3 = (σ1 + σ3) sinϕ+ 2c cosϕ

Since the cohesion will be small, assume c = 0:

σ1−σ3
σ1+σ3

= sinϕ

370−100
370+100

= sinϕ

ϕ = 35o

ψ =ϕ− 30 = 5o

For reasons of numerical stability, use c = 1 kPa
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Stiffness parameters

Since excavation is considered in this exercise, the input of Young’s modulus E should be
based on unloading, rather than on primary loading. For the same reason, Poisson’s ratio
should also be based on unloading, which results in a somewhat lower value.
The triaxial test has a cell pressure σ3 = 100 kPa. This corresponds with reference pressure,
so E50= Eref

50 .

Eref
50 = ∆σv

∆εv
= 135

0.675%
= 2.0 · 104kPa

For Sand it can be assumed that
Eref
oed = Eref

50 = 2.0 · 104kPa

Eref
ur ≈ 4 ∗ Eref

50 = 8.0 · 104kPa

m = 0.5

Additionally it is assumed that:
Gref

0 = 1.25 · Eref
ur = 1 · 105kPa

γ0.7 = 1.5 · 10−4

22 Computational Geotechnics



Tied-back excavation using HSsmall

APPENDIX B: MATERIAL PROPERTIES SECANT WALL

For a plane strain model material properties for the secant wall have to specified per meter
length of the wall. In order to do so we first recognize the secant wall as consisting of repetitive
parts at a certain intermediate distance, as shown in Figure 19.

DD

Figure 19: Secant wall as repetitive equal sections

Compared to the original bored piles the repetitive sections have a reduced cross sectional
area. Though it can be analytically derived how much the reduction is, the fastest way to
determine this is to draw the repetitive section on paper with a fine grid based on the original
bored piles with a diameter of 1000mm and an overlap of 200mm and count squares. Using
this method the cross sectional area of the repetitive section is determined as As = 0.74 m2.
Since the sections are at a distance D apart where D is given as 800mm, the cross sectional
area of the wall per meter is given as:
Awall =

As

D
= 0.74

0.8
= 0.93 m2/m

For the moment of inertia is assumed that the influence of the reduced cross sectional area
is negligble as the reduction is close to the axis of bending and symmetric. Therefore the
moment of inertia per meter wall is determined as:

Iwall =
Ipile
D

=πr4

4D
= π·(0.5)4

4·0.8 = 61.3 · 10−3 m4/m

With Econcrete = 2.7 · 107 kN/m2 this gives

EA = (2.7·107)(0.93) = 2.5·107 kN/m
EI = (2.7·107)(61.3·10−3) = 1.67·106 kNm2/m

And for the weight:

w = γ·A = 16 · 0.93 = 15 kN/m/m
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